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Getting Started

Welcome to the official Apple Pro Training Series course for Logic Pro 11.
This book is a comprehensive introduction to professional music produc-
tion with Logic Pro 11. It uses real-world music and hands-on exercises to
teach you how to record, edit, create, arrange, produce, mix, and master

music in a professional workflow. So let’s get started!

The Methodology

This book takes a hands-on approach to learning the software, so you'll be work-
ing through the project files and media you download from www.peachpit.com.
Its divided into lessons that introduce the interface elements and ways of working
with them, building progressively until you comfortably grasp the entire applica-
tion and its standard workflows. (See the “Access the Lesson Files” section for
more information on accessing the project files and media.)

Each lesson in this book is designed to support the concepts learned in the
preceding lesson, and first-time readers should go through the book from start
to finish. However, each lesson is self-contained, so when you need to review a
topic, you can quickly jump to any lesson.

The book is organized as 13 lessons that are designed to guide you through the
music production process as it teaches Logic Pro.

Lesson 1 establishes a solid foundation of key skills: navigation and zooming.
You'll become familiar with the interface and the various ways to navigate a
project.

Lesson 2 walks you through creating a project from the ground up, using
Apple Loops and editing regions in the Tracks area to create an arrangement.


http://www.peachpit.com

System Requirements

In Lesson 3, you'll explore effect and instrument plug-ins, use the Library to load patches
and presets; and save your own plug-in settings.

Lesson 4 dives deeper into typical situations that you may encounter when recording
audio sources, such as microphones, guitars, and MIDI keyboards.

Lessons 5 through 8 explore the new Session Players to create virtual drum, bass, and
keyboard tracks. You'll then create your own custom chord progressions in the Chord
track to make them play in harmony.

Lesson 9 sets you up to create content by programming MIDI in the Piano Roll, creating
drum beats and step automation in Logic’s new Step Sequencer, editing Audio regions;
and adding fades and turntable start and stop effects.

In Lesson 10, after separating instruments from a fully mixed audio file, you'll sample
vocals and drums from the separated tracks and import them into Quick Sampler and
Sample Alchemy to create a variety of sampler instruments. You'll play with Beat Breaker
to reshuffle and manipulate slices from a guitar arpeggio.

Lesson 11 explores various ways to edit the pitch and timing of your recordings, using
Smart Tempo to ensure that all your audio files play at the same tempo; creating custom
tempo curves; using groove tracks and Varispeed; time-stretching audio; and tuning vocals.

In Lessons 12 and 13, you’ll study the end processes of music production: mixing, and
automating using track stacks and EQ, compressor, limiter, delay, and reverb plug-ins. You'll
export your final mix as a stereo audio file after optimizing it with Mastering Assistant.

Appendix A, which is online, offers a series of Q&As to test your newly acquired knowledge,
while Appendix B, which is also online, lists all the keyboard shortcuts used in the book to
streamline your workflow.

System Requirements

Before jumping into Logic Pro—Apple Pro Training Series: Professional Music Production,
you should have a working knowledge of your Mac and the macOS operating system.
Make sure that you know how to use the mouse or trackpad and standard menus and
commands, and how to open, save, and close files. If you need to review these techniques,
refer to the printed or online documentation included with your system.

Xi



xii  Getting Started

Logic Pro 11 and the lessons in this book require the following system resources:

» macOS Ventura 13.5 or later
» 72 GB (minimum) of storage space for full Sound Library installation
P High-speed internet connection for installation

» MIDI keyboard (optional but recommended to play and record software instruments)
connected via USB or via a compatible MIDI interface

NOTE » ChromaGlow and Stem Splitter are available only on Macs with Apple Silicon
processors (M1, M2, M3, M4, and so on). Some projects in this book use ChromaGlow,
so if you open these projects on an Intel-based Mac, you'll receive a message indicating
that ChromaGlow is unavailable. Click OK and proceed with the exercises as usual.
While the project may not sound exactly as intended, you’ll still be able to complete the

exercises.

Prepare Your Logic Pro Workstation

The exercises in this book require that you install Logic Pro 11 along with the full Apple
Sound Library (not including the Legacy and Compatibility content). If you have not
yet installed Logic Pro, you may purchase it from the App Store. When your purchase is
completed, Logic Pro 11 will automatically be installed on your hard drive, and you’ll be
prompted to perform various tasks:

1 When prompted, download and install Essential Sounds. You must enter your password
to complete the installation.

2 When prompted to download more sounds, continue to download and install all the
sounds.

3 When prompted to download the instruments and loops for Session Players, click
Download 3 Packages.

4 To make sure the complete Apple Sound Library is installed on your Mac, choose
Logic Pro > Sound Library > Open Sound Library Manager. Resize the window as
needed to see all the packages listed and make sure everything (except for Legacy and
Compatibility) is installed.
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ece Sound Library Manager
Additional Contant Packages Status
Essantial Sounds and Instruments for Logic Pro and MainStage Instalied
> Sound Packs Instalted
Producer Packs Instalied
* Alchemy Sound Litraries Instalied
Sidio Bats Instaliad
Cinematic Instalied
Drum Kit Instaited
Electronic Drum Kit Instalied
Guitar Instalied
Mallet Instalied
" Orchestral Instalied
Percussion Instolied
Studio Plano Instalied
Studio Horns. Instalied
Studio Strings Ingtalisd
Vintage Mellotron Instalied
> wond Instatied
* Apple Loops Instalied
' Reverts Instalied
* Legacy and Compatibility Incomplete
Cancel

Some of the instructions and descriptions in this book may vary slightly, depending on
the sounds you have installed.

NOTE » If you choose not to download the entire Logic Sound Library, you may be
unable to find some of the media needed in the exercises. Missing media will appear
dimmed with a down arrow icon. Click the down arrow icon to download that media.

Access the Online Appendix A, Appendix B, and Lesson Files
Use the following instructions to claim the full benefits of your guide purchase.

If you purchased an eBook from a different vendor or bought a print book, you must reg-
ister your purchase on Peachpit.com to access the online content:

1 Go to peachpit.com/logicproll.
2 Sign in or create a new account.

3 Access the online Appendix A, Appendix B, and lesson files through the Registered
Products tab on your Account page. Click the Access Bonus Content link below the
title of your product to proceed to the download page. Click the link to the lesson
files or the online appendices to download them to your computer.


http://Peachpit.com
http://peachpit.com/logicpro11
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4 Unzip the file(s) you downloaded to access a folder titled Logic Book Projects,
which you should save to your Mac desktop or to a folder of your choice. Each lesson
explains which files to open for that lesson’s exercises.

NOTE » If you've enabled the Desktop and your Document folder to sync to iCloud,
you are strongly advised not to copy your lesson files to your Desktop. Choose
another location, such as the Logic folder within your Music folder.

Use Default Settings

All the instructions and descriptions in this book assume that you are using the default
Logic Pro settings (unless instructed to change them).

If you have changed some of your Logic Pro 11 settings, you may not see the same results
as described in the exercises. To make sure that you can follow along with this book, it’s
best to delete the Logic Pro PLIST file before you start the lessons. Keep in mind, however,
that when you delete the PLIST file, you lose your custom settings and key commands,
and later you may want to reset your favorite settings manually.

NOTE » To locate your Logic Pro PLIST file, it’s essential that you follow the
following instructions for accessing your user Library folder. If you go to
Macintosh HD/Library/Preferences/ instead, you won’t find it.

1 Quit Logic Pro.

2 In the Finder in the menu bar at the top of the screen, click Go.

The Go menu opens.

3 Hold down Option.

The hidden Library folder appears in the Go menu.
4 Inside the Go menu, click Library.
5 Inside the Library folder, open the Preferences folder.

6 Inside the Preferences folder, locate com.apple.logic10.plist and move that file to
your desktop.

7 Open Logic Pro.
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8 If a dialog prompts you to download more sounds, click Download Later.
9 If a window titled What’s New in Logic Pro opens, click Continue.

10 If a window titled Session Player Instruments opens, click the X at the top left of the
window to close it.

Enable Complete Features

This book assumes that you have enabled the complete features. Choose Logic Pro >
Settings > Advanced and make sure that Enable Complete Features is selected.

Use the U.S. Key Command Preset

This book assumes that you are using the default key command preset for a U.S. keyboard.
If you have customized your key commands, you may find that some of the key com-
mands in your Logic Pro installation do not function as they are described in this book.

If at any point you find that the key commands don’t respond as described in this book,
make sure the U.S. key command preset is selected on your Mac by choosing Logic Pro >
Key Commands > Presets > U.S.

Screen Resolution

Depending on your display resolution, some of the project files may appear different on
your screen than they do in the book. When you open a project, make sure you resize the
project window as needed to see the entire project.

When using a small display, you may need to zoom or scroll more often than instructed in
the book when performing some of the exercise steps. In some cases, you may need to tem-
porarily resize or close an area of the main window to complete an action in another area.

About the Apple Pro Training Series
Logic Pro—Apple Pro Training Series: Professional Music Production is a self-paced learning
tool developed by experts in the field.

For a complete list of Apple Pro Training Series books, visit www.peachpit.com/apple. For
more on certification, visit training.apple.com.
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Resources

Logic Pro—Apple Pro Training Series: Professional Music Production is not intended as a
comprehensive reference manual, nor does it replace the documentation that comes with
the application. For comprehensive information about program features, refer to the fol-
lowing resources:

P Logic Pro Help, accessed through the Logic Pro Help menu, contains a description
of most features. Other documents available in the Help menu can also be valuable
resources.

» The Apple websites www.apple.com/logic-pro/ and www.apple.com/support/logicpro/.

v

The ofticial Logic Pro release notes: https://support.apple.com/en-us/HT203718/.

» The Logic Pro Help website, an online community of Logic users moderated by the
author of this book, David Nahmani: www.logicprohelp.com/forums.

P For additional help with accessing the lesson files, you may send email queries to
ask@peachpit.com.


http://www.apple.com/logic-pro/
http://www.apple.com/support/logicpro/
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Lesson 5
Create a Virtual Drum
Track

In most popular modern-music genres, drums form the backbone of
the instrumentation. They provide the foundation for the tempo and
groove of the piece, and they are often recorded or programmed first so
they can provide a rhythmic reference for the other musicians to listen
to when they record their instrument.

In Logic Pro, you can leverage the virtual Session Players to quickly lay out a
drum track. You can choose which kit pieces the Drummer plays, how busy or
how hard to play, how many fills to add, and so on. It's almost like communicat-
ing with a real drummer to detail the style of playing you need for your song.

In this lesson, you’ll edit and arrange Session Player regions that contain a
variety of drum performances to lay the foundations for a new song that you
will continue to build in the following lessons.

Select a Drummer Style

To get started, you'll create a Session Player track, which is a software instru-
ment track where you arrange Session Player regions. You'll then select a style
for the performances contained in these regions in the Session Player Editor
pane at the bottom of the main window.

Create a Session Player Track with a Drummer Region

Let’s open a new project, add a Drummer track, and examine the display of the
drum performance in the Drummer region.

1 Choose File > New (or press Command-Shift-N).

139



140 Create a Virtual Drum Track

2 In the Create New Track dialog, click the Session Player button and make sure
Drummer is selected.

Create New Track

o ®@. O

MIDI Pattern Session Player Audio
Software instrumant Sofrware Instrumant m Mic or Line
Extrnial MInI Exturnal MIDI Rass Playwr Guitar or Bass
Koytoard Playne

In the Drummer Style pop-up menu, keep Pop Rock selected. You'll change the style later.

3 Click Create (or press Return).

Functions ~  View

A software instrument track (SoCal) is created along with an 8-bar Session Player region
(Drummer - Pop Rock). In the inspector, the SoCal patch (a drum kit patch that uses the
Drum Kit Designer software instrument) is loaded on the SoCal channel strip.

At the bottom of the main window, the Session Player Editor opens, allowing you to
edit the performance contained in the selected Session Player region.
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At the top of the main window in the LCD display, the project tempo is set to 110
bpm, which suits the pop rock music genre.

4 Press the Space bar to listen to the Session Player region.

The Drummer plays a straightforward rock pattern—a simple drum fill in the middle
of the region (before bar 4) and a second, more complex fill at the end.

Let’s take a closer look at the Session Player region.

5 In the workspace, Control-Option-drag around the first bar of the Session Player region.
Hi-hat

e b = o B -

od |
ﬁ» ) ) )

Kick Snare

The Drummer region displays drum hits as triangles on lanes, roughly emulating the
look of drum hits on an audio waveform. Kicks are shown on the bottom lane, snares
are shown on the middle lane, and cymbals are shown on the top lane. When toms or
hand percussions are used, theyre on the top lane along with the cymbals.

To create a cycle range of the desired length, you can drag the ruler horizontally.

6 In the upper-half of the ruler, drag from bar 1 to bar 2.

e

.--------—.-—--—-.--—--

kel |
%fb ) ) )




142 Create a Virtual Drum Track

10

A cycle range is created for the section you drag, and Cycle mode is turned on.

Listen to the first bar a few times while looking at the drum hits in the Session Player
region.

Although you cannot edit individual drum hits in the Session Player region, the
region display gives you a quick glance at the Drummer’s performance.

Click the cycle area to turn off Cycle mode.
Press Z to zoom out so that you can see the entire Session Player region.

Choose File > Save (or press Command-S) to save your song with a name and in a
location of your choice.

Remember to save your work at regular intervals throughout this lesson. You'll continue
working on this file in the next lessons.

Now, you can read the Drummer region. In the next exercise, you’ll listen to presets in dif-

ferent styles. Later, you'll watch the pattern update in the Drummer region as you adjust
its settings in the Drummer Editor.

Choose Styles and Presets

When you select a style in the Session Player Editor, Logic Pro loads the software instru-

ment patch that is best suited for that genre. Let’s preview a few styles and presets and

select one that works for your song.

1

In the Session Player Editor, click the little Play button at the upper left of the Drummer
- Pop Rock region.

The region starts playing in Solo and Cycle modes.
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Throughout this lesson, continue to stop and start playback as needed to hear the
results of your adjustments. Now that the Session Player has key focus, you can press
Option-Space bar to toggle this Play button.

In the Session Player Editor menu bar, click the Preset pop-up menu and choose Mixtape.

Echo Park
Golden State
Chords ~ L Half-pipe

1

(3] Drummer - Pop Rot HONKICKE

g Ocean Boulevard
¥ ] Paper Hearts

Copy

In the Session Player Editor, the knobs and sliders adjust to reflect the values of the
preset, and in the Session Player region, the performance updates.

The Drummer plays a busier groove with a ride cymbal, more kicks, and more ghost
notes on the snare (ghost notes are lower volume syncopated notes that add a subtle
rhythmic feel around the stronger notes).

In the Session Player Editor, click the Session Player button.

Session Player button

The Session Player dialog opens. You can change the type of Session Player and select
a style. The styles displayed depend on the type of player selected. For the Acoustic
Drummer type, you can select styles from four main categories: Rock, Songwriter,
Alternative, and R&B.

143
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Create a Virtual Drum Track

R To keep the current patch when selecting a new style, disable the Change
Patch switch.

In the Session Player dialog, click the Type pop-up menu and choose Electronic
Drummer.

In the Session Player dialog, the style categories update to Electronic, Hip Hop, and
Alternative.

In the Hip-hop category, select Modern Hip Hop.

In the inspector, the patch associated with that style (Platinum Cuts) is loaded to

the track’s channel strip. That patch uses DMD (Drum Machine Designer), and the
Drummer plays a swung, half-time hip hop groove played on a drum machine. In the
Session Player Editor, the controls update to display electronic drum parameters.

The project tempo is set to 95 bpm.

NOTE » In the LCD display, if the tempo does not automatically update when you
choose a style, double-click the tempo value to enter the desired tempo.

Feel free to explore more Session Player types, styles, and presets before moving on.

Select the Acoustic Drummer type and the Funk Rock style.

Rock
Pop Rock
‘Retro Rock
Chords Hard Rock:

Punk Rock

v/ Funk Rock [

Psychedelic Rock

ntensity



Edit Session Player Regions

The Smash patch is loaded on the track. The Drummer plays an energetic funky
groove on a powerful drum kit. In the LCD display, the tempo is set to 95 bpm.

il k|| e e

Cmaj

You have found a Drummer that plays the funky groove you want for this project on a
punchy-sounding drum kit and set a tempo that works well for the genre. You're now
ready to customize the performance.

Edit Session Player Regions

In the Session Player Editor, editing a performance is almost like communicating to a
real musician the parts you want them to play. For each Session Player region, you select
preset patterns (or create your own) and adjust various parameters. Then the Drummer
produces a performance that follows your instructions.

Adjust the Drum Fills and Select a Hi-Hat Pattern

In this exercise, you'll ask the Drummer to rein in the energy, stop playing fills, and hit
the ghost notes harder on the snare to accentuate the syncopated groove.

1 In the Session Player Editor, drag the Fill Amount knob all the way down to 0%.

Fill Amount «

;I

The Drummer no longer plays any drum fills. Let’s select a new hi-hat pattern.

145



146 Create a Virtual Drum Track

2 Next to the hi-hat Kit Piece button, click the Pattern button.

@.... L LI (N N ]

Kit Piece buttons Pattern button

In the Patterns dialog, patterns are represented on a grid of dots grouped as four beats
of four sixteenth notes each. These dots show a rough idea of what the Drummer may
play depending on other settings such as the Complexity slider.

Pattern 2 shows that the hi-hat plays every eighth note but the dots on the beat are
dimmer while the dots on the upbeats are darker, indicating that the Drummer will
accent the upbeats.

3 In the Patterns dialog, click pattern 2.

The hi-hat plays eighth notes, and the Drummer accents the upbeat. Let’s listen to the
hi-hat in isolation.

4 Click both the kick and snare Kit Piece buttons.
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The kick and snare Kit Piece buttons are dimmed to indicate that they are muted.
Inside the region, only the hi-hat notes remain in the top lane, and you can clearly
hear the hi-hat groove. It sounds like a disco beat, which will work great for this song.

5 Click the kick and snare Kit Piece buttons to unmute them.

Next to the kick and snare Kit Piece buttons, you can choose a pattern for the kick
and snare. In the next exercise, you'll create your own custom pattern.

Create a Custom Pattern

To really make this drum groove your own, you’ll now create a custom pattern, clicking
steps on rows to sequence the kick and the snare individually.

1 In the Session Player Editor, click the Manual button.

Main Details Manv'l_gl

You can create individual kick and snare patterns on two rows of 16 steps.

2 On the kick row, click the first and third steps, and on the snare row, click the first
step of beat 2.

The Drummer plays the pattern you've started to create. On the Session Player region,
you can see the kick and snare notes match the steps you've turned on.
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3 On the kick row, turn on the fourth step of beat 3 and the second step of beat 4. On
the snare row, turn on the first step of beat 4.

The Drummer keeps repeating your custom 1-bar pattern. To add variety, let’s turn
your pattern into a 2-bar pattern and switch things up in bar 2.

4 Click the Length pop-up menu and choose 2 Bars.

Next to the Length pop-up menu, two overviews appear for the two bars.

5 Click the overview of bar 2 (which is currently empty).

Let’s turn on steps in bar 2 to complete the pattern.

6  On the kick row, click the following steps:
P beat 1, step 1

P beat 3, step 3
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7  On the snare row, click the following steps:

P beat2,step 1

P Dbeat 4, steps 1, 3, and 4

Now, you have a unique kick and snare pattern. Let’s make the Drummer play a bit
more and hit the drums a little harder.

8 Drag the Complexity slider so it’s about three quarters up and drag the Intensity

slider all the way up.

Acoustic Drummer  Complexity Intensity
Funk Rock

The difference is subtle, but the Drummer now plays some sixteenth notes on the hi-
hat and plays slightly louder.

R To compare the results before and after changing a parameter in the Session
Player Editor, press Command-Z to undo, and then press Shift-Command-Z to redo.
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9 Click the Details button and drag the Dynamics knob all the way down.

Main | Details Manual

Reducing the dynamic results in less volume difference between the stronger and the
softer notes. The ghost notes on the snare are now louder, and the syncopation they
create is accentuated.

You've created your own unique custom pattern that will form the basis of the groove
used for your song. In the following exercises, you’ll create, edit, and arrange a few more
Session Player regions to complete the drum track.

Arrange the Drum Track

To continue arranging your drum track, you’ll create more Session Player regions to add
sections to your song and continue editing their performance to produce different drum
grooves for each section.

Create the Intro

To create an intro, you'll create a copy of the Session Player regions in the workspace and
edit the first copy to create an intro.

1 Choose Edit > Repeat > Once (or press Command-R).

In the workspace, a copy of the Session Player region is created at bar 9.

2  Click the first Session Player region at bar 1.

The region is selected, and you can edit it in the Session Player Editor.



3

5

6

Arrange the Drum Track

Drag the Complexity and Intensity sliders all the way down.

Acoustic Drummer Complexity Intensity
Funk Rock

The Drummer is much quieter in this new intro, playing side sticks (hitting the rim of
the snare to create a softer sound, almost like a woodblock). At bar 7, the Drummer
switches back to hitting the center of the snare and progressively raises the intensity to
reach the level required to play the second region at bar 9.

Let’s use the Marquee tool (your Command-click tool) to split the first region into two
regions of equal lengths so you can make the performance evolve during the intro.

Command-double-click at bar 5.

Drurmmer = Funk Rock

The region splits in two. Let’s edit the first region’s custom pattern.
Click the region at bar 1 to select it.

In the Session Player Editor, click the Manual button.

151
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7 Click the Length pop-up menu and choose 4 Bars.

To the right of the Length pop-up menu, four overviews allow you to access the 16
steps in each one of the four bars.

8 At the upper right, click the action menu and choose Reset.

Jetails  Manual

The kick and snare rows are emptied. To start the song, you’ll create a simple pattern
without kick drum.

9 In the snare row, in each of the four bars, click the first steps of beats 1 and 2.

10 In bar 4, beat 4, click steps 1, 3, and 4.
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11 Click the Details button.

12 Drag the Ghost Notes knob all the way up to 100%.

Main | Details Manual

Snare darcussion Hi-Hat
Automatic Half-Closed

The Drummer plays many more side-stick notes, which adds complexity to this part
of the intro. Let’s make the hi-hat ring a little more.

13 Click the Hi-Hat pop-up menu and choose Open.

Snare Percussion Hi-Hat
Automatic Off Half-Closed

Automatic
Closed

v Half-Closed
Half-Open

Wide Open

Now you’ll work on the second part of the intro.

14 Click the second region at bar 5.

At bar 7, the Drummer starts playing regular snare hits; however, you want to keep
side sticks throughout the entire intro.

15 Click the Details button.
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16 Click the Snare pop-up menu and choose Side Stick.

Main Detalls Manual

v Automatic
Center
Rim Shot

_side Stick |

Tom Percussion Hi-Hat

Automatic Off

Now the Drummer plays the side stick throughout the entire intro. Let’s add some
shaker to this second half of the intro.

17 Click the Percussion pop-up menu and choose Shaker 3.

Snare ‘ercussi Hi-Hat
Side Stick aker Half-Closed

The shaker is very quiet; let’s turn it up.

18 In the control bar, click the Smart Controls button (or press B).
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19 In the Smart Controls pane, turn up the Percussion knob to about 3 oclock.

You can now better hear the shaker, which adds a nice texture to this second part of
the intro.

R For more control over the sound of your drums and the effects used to pro-
cess them, open the plug-ins on the Smash channel strip in the inspector.

You've used the Session Player Editor to adjust the complexity and intensity of the Drummer’s
playing. You've selected different drum kit pieces, added hand percussions, and adjusted the
number of fills and ghost notes in different regions. Now that you have a good grasp on the
Session Player Editor, you'll add a few more regions to continue building the drum track.

Create Markers for Song Sections

To make it easier to navigate the arrangement and identify song sections, you'll create
markers for the intro and verse you've already created as well as for the remaining sections
you'll create later.

1 At the top of the track headers, click the Global Tracks button (or press G).

Edit Funclions View

Arrangement
Marker

Tempo

Signature

Chord
Smash
M S

e .
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The global tracks open. You need to see only the Marker track.

2 Control-click a global track header and choose Configure Global Tracks (or press
Option-G).

3 Turn on Show Single Track and select Marker.

Edit Functions

Markaer

Smash

M S

T

To create markers for the existing song sections, you can drag your regions into the
Marker track.

4 Click the Smash track header (or press Command-A).

All the regions on the track are selected.
5 Drag the selected regions to the Marker track.

(]
" e el ST
Orummee - fynk Rsek | Orumemar - Funk Rk | Oremmee . Funk Raek

Drummar - Funk fiock | Drummer - Fusk fAiock  Ornammar - Fun fiock

e TR T DT S B B

bbb 0 O 0 O 0

TR T

Three markers are created. They have the same color and name as the regions you

dragged. Let’s create more markers for the remaining song sections.

6 Click the background (or press Shift-D) to deselect the markers.
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You can copy and resize markers in the Marker track the same way you edit regions in
the workspace.

7 In the Marker track, Option-drag the marker from bar 9 to bar 17.

* | Drummer - Funk Rock

21

7
Drummer = Funk Rock

9 Option-drag this new 4 bar-long marker to bar 21.
10 Option-drag this last marker to bar 25.

11 Resize this marker at bar 25 to make it 8 bars long.

17 il 25 29 33

-- e ey

+4000

Now that you have all the markers you need, let’s rename them and give them custom
colors.

12 Double-click the first marker, enter Intro 1, and press Tab.

The marker is renamed, and the text field opens on the next marker.
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13 Continue this procedure to rename the following markers:

>

>
>
>
>

inten )

Marker at bar 5 = Intro 2
Marker at bar 9 = Verse
Marker at bar 17 = Bridge
Marker at bar 21 = Rise

Marker at bar 25 = Qutro

intrs 3 Virua

Ot - Funk Riock | Drimmar « Fink Rock  Dnmsas - Funk Rock

14 Choose View > Show Colors (or press Option-C).

The Color palette opens.

15 Choose different colors for your markers.

Adding markers helps identify song sections and later will help you navigate the song.

Your song structure is now complete, and you are ready to start working on the Bridge,

Rise, and Outro sections.

Convert Session Player Regions to MIDI Regions

Now, you’'ll create a new Session Player region for the bridge. After you start editing the
new region and realize that your edits affect how the Drummer plays the verse, you'll con-

vert the verse region to MIDI to prevent it from changing.
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1 Position the pointer to the right of the last Session Player region and click the + sign
that appears.

Verse Bridge

' Drummer - Funk Rock

A
WEREAE

A new 8-bar Session Player region is created at bar 17.

2 Resize the new region to a length of 4 bars.

Verse

- Drummer - Funk Rock Drummer - Funk Rock

-
A

Length (

3 Double-click the new 4-bar region (or press E) to open the Session Player Editor.

During this bridge, let's make the Drummer perform a simple and quiet pattern.
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4

5

In the Session Player Editor, drag the Complexity slider all the way down.

Drag the Intensity slider all the way down.

Verse

Drummer - Funk Rock Drummer - Funk Rock

B RPIP DD DDDD PO DRI R DRI ID DRI DDR PO bbb

DO I 1 1
LA AEN]

Listen to the transition from the verse to the bridge and look at the regions. At the

end of the verse, the Drummer progressively lowers his intensity to ensure a smooth
transition to the bridge. However, for this song, you want an abrupt transition from
the intense groove in the verse to the quiet bridge.

Press Command-Z.

The Intensity slider goes back up, and the Drummer performance stays intense until
the end of the verse. To prevent that Session Player region in the verse from updating
when you edit other regions, you'll convert it to a MIDI region.

Control-click the region in the verse and choose Convert > Convert to MIDI
Region (or press Control-Option-Command-M).

Bridge
Drummes - Funk Rock

ene B b b b B b R b e o] S b gt e a1

bbb 110N - - - -
| NRLR I o
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The Session Player region is converted to a MIDI region that plays the same notes. At
the bottom of the main window, the Piano Roll shows the MIDI notes inside the region.

8 Click the Session Player region in the bridge to select it.

9 In the Session Player editor, drag the Intensity slider all the way down.
Now the Drummer keeps the intensity up throughout the entire verse and suddenly
shifts to play a quiet pattern in the bridge.

A Session Player region can sometimes update its performance to adapt to other Session
Player regions immediately before or after it on the track. Converting the region to MIDI
allows you to keep the performance intact no matter how you edit other regions around it.

Complete the Bridge

Let’s continue editing the performance in the bridge to make the Drummer play a softer,
more open part and give that section more space.

1 In the Session Player Editor, click the Main button.

2 Click the hi-hat Pattern button and choose pattern 4.

=ill Amount o

To make this bridge breathe and create an impression of space, you'll remove all ghost
notes to make room for the reverb tails of the remaining notes.

3 Click the Details button and turn the Ghost Notes knob all the way down to 0%.

Now, you’ll make the Drummer play a tom rather than a snare.
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4  Click the Snare pop-up menu and choose Tom.

Ghost Notes

Percussion Hi-Hat
Off Half-Closed

To really give a different color to this bridge, let’s add a shaker and close the hi-hat.
5 Click the Percussion pop-up menu and choose Shaker 3.

6 Click the Hi-Hat pop-up menu and choose Closed.

Ghost Notes

Percussion Hi-Hat
Shaker 3 Closed N
R

The hi-hat notes no longer ring as much, which leaves more room to hear the shaker.
Increasing the volume range between the softer and louder notes will open this quiet
section even further.

7 Drag the Dynamics knob up to 130%.

Let’s edit the custom pattern to get a simple, straightforward drum beat.

8 Click the Manual button.
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9 Edit the pattern so that the kick plays beat 1 and 3 and the snare plays beat 2 and 4.

10 In bar 1, beat 1, make the kick play step 3.

You've created a quiet part for your bridge, where the Drummer plays the tom instead of
the snare. The pattern is sparser, and a shaker adds texture to this section. All these edits
produce a striking contrast with the verse before.

Complete the Rise and Outro Sections

To end the song, you’ll make the Drummer switch from the toms back to a snare, and
progressively bring the intensity back up.

1 Choose Edit > Repeat > Once (or press Command-R).

Drummer - Funk Rock

The Session Player in the Bridge section is copied to the Rise section.

2 Drag the Complexity slider a third of the way up.
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3 Drag the Intensity slider halfway up.

Acoustic Drummer  Complexity Intensity
Funk Rock

4 Click the Details button and set the Ghost Notes to 20%, Snare to Automatic, and
Percussion to Off.

Ghost Notes

\

Snare Percussion Hi-Hat
Automatic Off Closed

The Drummer plays a more complex and more intense groove with a regular snare.
Let’s add a very subtle drum fill at the end of the Rise section.

5 Click the Main button and drag the Fill Amount knob up to 1%.

A fill is added at the end of the region; however, it’s way too busy.
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6 Drag the Fill Complexity knob all the way down to 1%.

Fill Amount o'

Fill Complexity

Now the Drummer simply hits the toms a couple of times at the end of the region.
Let’s move on to the Outro section

7 Move the pointer to the right of the last region in the workspace and click the + sign.

A new 8-bar region is created with the same subtle fill at the end. To end the song,
you'll add a more complex fill.

8 Drag the Fill Complexity knob up to 50%.

R To try different fills, click the Perform Again button, and the Drummer pro-
duces a new subtle variation of the performance.

Complexity Intensity

Perform Again button
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9 Drag the Intensity slider almost all the way up.

10 Click the Details button and from the Percussion pop-up menu, choose Claps 2.

The hand claps in this section really help lift the groove and give it a human feel. It
almost makes you want to get up and clap along!

Let’s add one last Session Player region and make it small to end the drum track on a
downbeat.

11 To the right of the region in the Outro section, click the + sign to create a new region.

12 Resize the region to shorten it so that it contains notes only on the first beat.

To resize the region, you can pick one of two methods:

P Use the Help Tag to make sure the length of the regionis 0 0 I 0.

P Work in broad strokes, resizing the region, zooming in, and repeating the opera-
tion until you see notes only on the first downbeat.
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13 Save your project and keep it open for the next lesson.

You have previewed different drum styles and produced a variety of patterns for the differ-
ent sections of a funk rock song. With Drummer, Drum Kit Designer, and Drum Machine
Designer, Logic Pro allows you to quickly lay down a rhythmic foundation for a wide range
of modern music genres. In the next lesson, you’ll continue building upon this foundation
by adding a bass track to your song.

Key Commands

Keyboard Shortcuts Description

Tracks area

G Toggles the global tracks

Option-G Opens the Global Tracks Configuration dialog
Control-Option-Command-M Cone rts the & lected region to MIDI
Command-R B peats the e lection once

Option-C Toggles the Color palette

167
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A
additive synthesis, 300,
304-305
analog tape recorders,
275, 326
analysis, audio file, 311, 400
anchoring playheads, 11
Apple Loops
added to regions, 31-41
creating your own, 229,
269-271
imported into tracks,
313-315
imported into
workspace, 241
loop families, 50
project tempo conformity
by, 319
royalty-free, 275
Apple M1 chip, xii, 4
Apple Pro Training Series, x,
XV—XVi
Apple Silicon processors, xii,
277, 401
Arpeggiated style, 191, 194
Arpeggiator MIDI effect,
82-84
arpeggio patterns, 194, 195-
196, 197, 199
artifacts, 39, 41, 315
audio
converting MIDI region
to, 261
frequency shaping,
368-371
parallel processing of,
89-99
recording, 111-121

signal chain for, 350

slicing audio regions,
261-263, 294

See also regions

audio effects

Audio FX area, 69, 77, 99,
102, 356

automation curves for,
392-396

Beat Breaker for,
294-300

drum track, 155

infinite sustain
effect, 100

MIDI effect plug-ins,
82-84

order of, 99

plug-in settings, 73-77

recording and, 113-114

submixes for, 354

turntable effects, 229

audio files

adapting project tempo
to, 309-315

analysis information, 311,
400

Apple Loop
creation, 269

deleting outtake files,
127-130

detecting tempo in,
310-313

exporting master to,
402-404

instrument tracks
from, 278

joining/repeating regions
in, 264

nondestructive editing
of, 128
properties
information, 128
saving, 33
Audio FX area, 69, 77, 99, 102,
356
automation
automated pitch bend,
257-261, 392
automated steps,
244-246, 257-258
automatic punching,
124-127
mix parameter
automation,
391-399
real-time recording of,
396-399
Automation Curve tool, 261
Autopunch mode,
124-127, 137
auxiliary channel strip, 86,
89-92

B
bars, 7
bass track
bass loops, 39-41
chord progressions, 169-
172, 210, 212-215,
218, 219, 223-224,
227
distortion added to,
352-354
editing/arranging regions,
174-187
previewing styles for,
172-174

405
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Beat Breaker, 294-300
beats, 8, 229-246, 269,
281-286
bend, pitch, 247,
257-261, 271
Block Chords style, 191, 202
Bounce, 402-404
breaks, taking, 387
bridge
bass track, 180-184
drum track, 160-163
editing chords in,
223-225,227
keyboard track,
194-196, 201-202
Broken Chords style, 190, 191,
192, 199
Browsers button, 27
bus sends, 86, 89-94, 98

C
changing tempo, 319-323
character, saturation to add,
346-354
choppiness, 263, 265
chops, vocals, 291-293
Chord track
bass track and,
169-172, 175
chord groups, 214-217,
223-224
chord progression
loops, 52
editing groups/choosing
scales, 217-219
editing regions, 219-223
keyboards and, 190, 200
preset progressions,
210-214
project setup, 209-210
chords
chord progressions, 52,
209, 246, 271
chord roots, 212
customized progressions,
214-227

grouping/ungrouping, 219
key commands for, 227
loops with chord
progressions, 52,
169-172
Polyphonic mode
for, 332
previewing, 209-214
region chords, 219-223
saving custom, 271
sustained single,
206-207
ChromaGlow
Apple Silicon processor
for, xii, 4
drum track with,
346-348
strings with, 349-352
Classic mode, 280, 286,
287, 291
Clean Up Project, 130
cohesive elements, 345, 401
color coding
marking track
sections, 158
note velocity values, 253
track customization via,
60-63
Complete Features, xv
Complexity slider
bass track, 175, 177, 178,
181, 184
drum track, 146, 149,
151, 160, 163
keyboard track, 200
composite takes, 117,
121, 124
compositions, 214, 275
compression, 69, 86, 330, 374,
379-384, 399
consoles, mixing, 391
content creation
Apple Loop creation,
269-271
key commands for, 272

programming drum beats,
229-246
programming Piano Roll,
247-261
continuous repeats, 6-9, 38
Control bar, 17, 18
converting files, 402-403
copies
plug-in copies, 99-105
region copies, 43-44
copyrights, 275
corrections.
See mistakes
creating projects, 31-34
creative
experimentation, 229
crossfades, 49, 289
curves
curving fades, 267
drawing automation
curves, 392-396
frequency spectrum
curve, 375
pitch bend curves,
258-260, 341, 342
tempo curves, 310-313,
319-323
volume curves, 298-300
customization
arpeggio patterns, 195-
196
chord progressions,
214-227
color coding tracks,
60-63
drum pattern, 147-150
saving plug-in/patch
settings, 106-109
screenset customization,
360-362
cuts, healing, 264-265
Cycle mode
looping sections with,
6-9
MIDI merges in, 137
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previewing loops
with, 38

programming drum beats
with, 234

recording takes in,
119-121

turning off, 16

data stream, mix, 391
dead notes.

See ghost notes

default settings

fast workflow via, 44

Logic Pro 11, xiv-xv

setting knobs/sliders to,
91

definition between

elements, 345

delay and reverb, 371-374
deletions

outtake deletions, 119,
120, 127-130
patch deletions, 108

depth, adding, 371-374,

384-387

distance, adding, 371-374
distortion

ChromaGlow effects,
346-348

parallel processing to
add, 352-354

plug-ins to add, 66,
72,77-79, 87, 99,
102-104

recording and, 114

dithering, 403

divisions, 8, 11
double-stops, 173
downbeat alignment, 277
dragging regions, 97
drum machines, 229
drum tracks

arranging, 150-167
ChromaGlow on, 346-
348

custom patterns,
147-150

drum fill adjustment,
139, 141, 145,
164-165

drum hit display on, 141

Drummer Style selection,
139-145

editing Session Player
regions, 145-150

groove matching,
323-326

hi-hat patterns, 145-147

intros, 150-155,
157-158

key commands, 167

mapped to pitch, 248

markers for song
sections, 155-158

peak levels, 347

programming drum beats,
229-246

rhythmic samples,
293, 294

slicing drum beats,
281-286

tempo syncs with,
313-315, 320

dry audio, 89, 114

Dual Mono format, 75

dub music, 100

dynamics, controlling, 379-

384

ear fatigue, 387
echoes, 100-105
editing

bass track, 174-187

changing pitch/speed,
309, 326-329

chord groups, 217-219,
223-224

chord progressions, 214

detailed, 24, 25, 42

drum pattern, 162-163

Index 407

keyboard track, 191-202
matching groove styling,
323-326
matching loop/project
tempo, 315-318
MIDI note editing, 134
nondestructive, 42, 128
patches, 84-89
plug-in parameters, 102
regions, 41-59, 219-223
Session Player
performances,
145-150, 161,
165, 192
Session Player styles,
139-145
sliced audio regions
for, 263
split region editing, 197
tempo changes, 309-315,
321-323, 330-337
tuning vocal recordings,
338-343
undesirable noises
from, 49
vocal chops, 291-293

Editors area, 22, 23-24
effects.

See audio effects

emotion, 209

EQ, 69, 91, 362-379, 399
experimentation, 229
exporting master files, 402

404

fades

applied to regions, 47-49,
266-269

crossfades, 49, 289

mixing consoles for, 391

plug-in, 79

removing, 267

single note samples with,
281
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feedback
feedback values, 99, 100
recording and, 113
fifths, 197-198
files, audio.
See audio files
fill, amount/complexity of
bass track, 175, 180, 181,
182, 184
drum track, 145,
164, 165
keyboard track, 200
flangers, 103
Flex editing
pitch changes with, 309,
338-343
tempo changes
with, 309, 320, 330-
337,343
Forward/Rewind buttons, 5
frequency shaping, 350, 362,
368-371, 374-379

G
Gain Reduction meter,
381, 382
Gate mode, 292
gating, 261, 263, 265, 396
genres, 345
ghost notes
adjusting number of,
150-155, 164
increasing value of, 153
space by removing, 161
syncopation and, 143,
145, 176
Global Tracks, 155-156, 170-
171, 209, 212,
213,219
granular synthesis, 300, 301
groups, chord, 214-219

H

hand percussion, 141,
154-155, 166

harmonic richness, 346

headphones, 113, 366

healing cut audio regions,
264-265
Help Tag, 7
hi-hat patterns
bridge pattern with,
161, 162
customizing, 149
intros with, 153
programming beats with,
235,
236-237, 241
selecting patterns,
145-147
workspace display
of, 141
horizontal sounds, 365
Horizontal Zoom, 9, 10

|
icons, custom, 60-63
ideas, saving, 269-271
incremental zooms, 9-13
infinite sustain effect, 100
input, audio, 111-112
inspector, 17, 18, 19-22
instruments
audio effect plug-ins,
73-77, 114
bass line creation,
247-261
chord progressions
of, 212
chord vs. single-note, 332
ChromaGlow for
lifelike, 348
drum track styling,
139-145
extracting instrument
stems, 275-278
mixing tools, 346-354
multi-timbral MIDI, 132
parallel processing of,
89-99
plug-ins for software, 69
punch ins/outs to modify,
126

Quick Sampler tracks,
279-290
recording MIDI,
130-137
software instrument
plug-ins, 79-82
Solo mode to identify,
70-73
Step Sequencer for, 229,
233, 246
summing track stacks of,
96-99, 357
tuning, 115
volume/pan/EQ/reverb
changes, 59, 63-66,
205, 362-374
Intel-based Macs, xii
Intensity slider
bass changes with, 175,
177,181, 183, 184
drum changes with, 149,
151, 155, 160, 161,
163, 166
intros
bass track, 177-180
drum track, 150-155,
157-158
keyboard track, 191-193

J
joining regions, 264-265

K

key commands
audio sampling
with, 307
chord progression, 227
content creation, 272
display of, 9
drum track, 167
global, 67
mixing shortcuts, 389
multiple panes and, 62
Musical Typing mode
and, 131
patches/plug-ins, 109



Play From Selection, 71,
73
playback control via, 3-6,
29
punching in/out via, 121
recording with, 137
selecting steps with, 232
soloing tracks, 71, 72, 74,
187
timing/pitch edit
keys, 343
toggling screensets
via, 357
Tracks area, 67
zooming with, 9-13, 15,
29
key signatures
changing loop key, 315
chord root in relation
to, 212
matching audio file/
project, 315-318
keyboard track
chord progressions,
210-213, 219,
221,223
editing/arranging regions,
191-202
performance styles, 202
previewing player styles,
189-191
string section, 203-207
keyboards
extended, with numeric
pad, 358
MIDI, xii, 131
Musical Typing
mode, 131
US., xv
kicks, drum
bridge pattern with, 163
custom pattern of,
147-149
display in
Drummer, 141
patterns without, 152

programming MIDI
with, 247, 248, 253,
257,261

sampling with, 279-281

Step Sequencer, 231, 235,
236-238

styling of, 143

knob values, 91, 95

L
latency, 112
lead vocals, 374-387
Learn mode, 244, 273
lengths
changing note length,
252-254
four values for, 7-8
Piano Roll editing of,
247,252
levels, recording, 111-117
Library
Apple Loop Library.
see Apple Loops
main workspace display,
19-22
patches from, 84, 85-87,
191, 204
royalty-free content
in, 275
settings saved in,
107, 108
software instrument
browsing in, 82
licensing rights, 31
List Editors, 25
live audio, 112
Live Loops grid, 18
locators
rounded, 46
setting left/right, 6, 7, 9
locked screensets, 359-362
Logic Pro
Apple Loops included
with, 31
Apple Pro Training
Series, X—Xi, Xv-xvi
automation, 391
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autosaves in, 34
custom Apple Loops in,
269-271
Flex Time editing
in, 330
installation, xii
MIDI recordings
and, 132
program features, xvi
Session Player
regions, 189
Sound Library, xii-xiii
system requirements, Xii
tempo detection by, 310
311, 316
workstation, xii-xv
Logic Pro—Apple Pro Training
Series: Professional Music
Production, x-xi, xv—xvi
Loop Browser, 26, 34, 38, 51,
270, 313
loops
adding, 31-41, 51-53
Bass Player chord
progression,
169-172
looping samples in
Classic mode,
286-290
popping sounds in, 289
previews during
playback, 38-41
programming
drum beats, 239
repeating regions, 41-44
switching between, 50
tempo matching for, 39
Loudness knob, 400
lyrics, incomprehensible, 291

M

macOS, xi-xii

macOS Sonoma, 114

main window panes,
17-27, 29

markers
slice markers, 281-283
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markers(continued)
song section markers,
155-158
transient Flex Time
markers,
330-335, 338
Marquee tool, 44-47, 127,
151, 182
mastering, 356
Mastering Assistant,
399-401
mastering projects, 399-401
melody
Arpeggiator MIDI effect,
82-84
bass line support
for, 257
bass track melodics, 174,
175-176,
181, 185
chords for, 209
experimenting with, 229
Step Sequencer for, 229,
233, 246
string section to
underline, 203
See also Chord track;
chords
Metronome settings,
116, 312
Mic Mode, 114
Microphaser, 75-76
microphones, 112, 114
MIDI
chord editing in, 221
content creation in, 229
events, 131-135
keyboard, xii, 131, 247,
279, 282
mapping slices to,
281-282
MIDI FX area, 69, 82
multiple channels
for, 132
playing sample notes
via, 279

programming Piano Roll,
247-261
project tempo conformity
by, 319
recording, 130-137
synthesis
techniques, 301
triggering software
instruments, 80
troubleshooting
connections, 132
MIDI FX area, 69, 82
MIDI regions
converting pattern
regions to, 247-249
converting Session Player
to, 158-161
merging takes in, 130,
135-137
recording, 131-134
summing track stacks
for, 97
window panes for, 18
mistakes
artifacts, 39, 41, 315
clicks from sampling,
279-281, 289
fades to heal, 266-269
healing cut audio regions,
261, 264
pops in loops, 289
punching in/out to fix,
121-127
volume levels, 363
Mixer, 23, 31, 54, 61-65, 89,
357-360
mixing
automating mix
parameters,
391-399
changing
pitch/speed, 326
key commands, 389
lead vocal chain,
374-387

mastering mixes,
399-401
multitrack recorders
for, 391
parallel processing, 89-99
saturation for character
in, 346-354
song mixing, 59-66
submixes, 275, 354-357
switching between Tracks
and,
357-360
tips and tricks, 387-388
two goals of, 345
volume/pan/EQ/reverb
changes, 362-374
mono signal, 365
Monophonic mode, 332
monotony, preventing, 50
moving regions, 41-44
muddiness, 345, 348,
351, 370
multiple takes, 117-121
multitrack recorders, 391
music distribution, 404
Musical Typing, 131

N
naming
new audio tracks, 112
renaming tracks/regions,
53-54
tempo set names, 319-
321
navigation

benefits of mastering, 41
continuous repeats, 6-9
controlling
playback, 3-6
editing via, 41
key commands, 3-6
main window
panes, 17-27
zooming in/out, 9-17
new projects, 31
Note Pad, 26
notes



assigning slices to MIDI
notes, 281-286

creating notes in Piano
Roll, 255-257

displaying pitch/velocity
for, 256, 258

editing MIDI notes, 134

expanding range of
keyboard, 194

ghost notes, 143, 150,
153, 155, 161, 164

length of, 84, 185

MIDI note on/off, 133

Monophonic mode for
single, 332

Piano Roll editing
of, 247

pitch bend automation,
257-261

programming
MIDI, 247

reordering notes,
294-298

sampling single notes,
279-281

time-stretching single
notes, 335-337

transposing, 249-252

o

octaves
bass track phrasing, 185
left-hand keyboard track,
195, 197, 198
MIDI effect plug-ins,
82-84
programming beats with,
240
transposing
up/down, 131
offline automation, 392
on-the-fly punching,
121-124
One Shot mode,
279-281, 292
operating system, xi-xii

organization, 354-362
outros
bass track, 184-187
drum track, 158,
163-167
editing chords in, 224-
227
keyboard track, 199-202
string section to enhance,
203

P
pan position
adjusting volume and,
63-66, 362-374
final mixdown and, 391
plug-in, 79
panes, main window,
17-27,29
parallel processing, 89-99,
352-354
patches
auxiliary channel
strip, 92
deleting, 108
disabling Change Patch
switch, 144
drum kit patches, 237
editing, 87-89
genre-specific styles, 142,
144
instrument enhancement
via, 70
keyboard shortcuts
for, 109
keyboard track styles,
189-191
Library patch use, 85-87
loading, 84-87
saving stacks as, 96
saving user settings for,
106-109
string section, 203-204
See also plug-ins
Pattern Browser, 233
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pattern regions, 241-243,
247-249
Patterns dialog, 146
PCM (pulse-code modulation)
wave files, 402
peachpit.com, x, xv-xvi
peak levels, 347
performance styles
bass track, 172-177
drum track, 142-145
keyboard track, 189-191
matching groove, 323-
326
saturation to adjust, 346
phasers, 73-77
phrasing, 181
Piano Roll
content creation in, 229,
247-261
editing in, 25,
133-134, 137
piano styles, 190-191
Pickup Hits, 176-177
pickup notes, 255-257
pitch
Arpeggiator MIDI effect,
82-84
bass track, 173, 176, 177
changing pitch/speed,
326-329
compression and control
of, 379-384
editing MIDI, 134
keyboard track, 194-195
loop note pitch, 289
mapping drum notes
to, 248
mapping slices to MIDI
pitch, 281-282
Piano Roll editing
of, 247
pitch bend automation,
257-261
pitch display, 256, 339
synthesis added to, 301
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pitch (continued)
transposing notes,
249-252
tuning vocal recordings,
338-343
Pitch Source, 211, 213, 219,
222,223
Play button, 4
Play From Selection, 71, 73
playback
adjusting speed of, 54-59
alternating forward/
backward, 289
Beat Breaker to
control, 294
changing pitch/speed of,
294-298, 326-329
continuous repeats, 6, 9
Control bar for, 18
edits and updates to, 48
key commands for, 3-6
loop preview during,
38-41
recording and, 113
Space bar to toggle, 172
plug-ins
automated in Step
Sequencer, 241
auxiliary channel strip,
90-91
Beat Breaker, 294-300
ChromaGlow, 346
dialing effects for, 77-79
editing parameters
of, 102
formatting, 75, 102
hiding/showing, 101
inserting, 69-84
instrument enhancement
via, 70
keyboard shortcuts
for, 109
legacy, 102
loading/editing patches,
84-89

looping samples
with, 290
MIDI effect plug-ins,
82-84
multiple channel strips
with, 105
multiple plug-in
processing, 99-105
recording and, 112, 114
Remix FX plug-in, 244
removing, 81
reordering/copying,
99-105
saving settings, 106—-109
Smart Control
adjustments, 87-89
step automation of, 229
synthesis techniques,
300-306
turning off superfluous,
86-87
undoing parameter
changes, 375
See also patches
Polyphonic mode, 332
presets
chord progressions,
209-214
drum styles/presets,
142-145
previews
Bass Player previews,
172-174
chord previews,
209-214
commercial mix
comparisons, 388
keyboard track previews,
189-191
loop preview in playback,
38-41
outside of the
studio, 388
recorded outtake
previews, 129

Solo mode for region,
70-73
processed audio, 89
projects
adding Apple Loops to,
31, 34-38
changing pitch/speed of,
326-329
creating/saving new,
31-34
mastering, 399-401
matching custom loops
to, 270
mixing songs, 59-66
setting up Chord
track, 209
zoom to fit for, 16-17
punching in/out, 121-127

Q
Quick Help, 21-22
Quick Sampler, 279-290

R
Record Toggle, 122, 123
recording
audio recordings,
111-117
count-in length, 116
key commands for, 137
merging MIDI takes,
135-137
MIDI recordings, 130-
137
multiple takes, 117-121
multitrack
recorders, 391
pitch corrections, 309
punching in/out to
correct, 121-127
real-time, of automation,
396-399
single note, 279-281
slower speed
recordings, 329
solo vs. with
engineers, 124



tuning vocal recordings,

338-343
Region inspector, 20,
212, 315
regions

adding Apple Loops to,
31-41

adding pattern regions,
241-243

automation curves in,
259, 393

changing parameters
on, 21

chord editing in,
219-223

color codes for, 60-63

converting to MIDI,
247-249, 261

copies of, 43-44,
201-202, 249

directional dragging of,
97

editing, 41-59, 174-180,
191-202, 261-279

Event list for, 25

fades applied to, 47-49,
266-269

joining/repeating,
264-265

muting/unmuting, 278

pasting chords
from, 213

previews of, 70-73, 129

recording over, 117

renaming, 53-54

resizing, 41-44, 166,
201-202, 242

rounded locators for, 46

Session Player.
see Session Player
regions

slicing regions, 261-263

splitting, 54-59,
197-199

summing track stacks
of, 95-99
tempo editing for,
330-337
time value of, 10
Tracks area to
arrange, 18
tuning entire, 340
Remix FX plug-in, 242, 243,
244, 246
remixes, 275
renaming regions/tracks,
53-54
reordering plug-ins, 99-105
repeating regions, 41-44,
264-265
repeating sections, 6-9
repeating slices, 298-300
resizing fades, 267
resolution, xv, 13
reverb, 69, 86, 89-95,
371-374, 384-387, 399
Rewind/Forward buttons, 5
riffs, saving, 269-271
rise section
bass track, 184
drum track, 158,
163-167
editing chords in, 2
24-225
keyboard track, 194-196
ritardando, 323
Roland TR-808, 229
room, virtual, 384
rounded locators, 46
royalties, 31, 275

S
Sample Alchemy, 300-306
sampling audio
copyrights
considerations, 275
editing tools for, 343
extracting stems,
275-278
history of, 275
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key commands for, 307
loops in Classic mode,
286-290
matching pitch/tempo
for, 309-318
mixing prerecorded
material, 309
Quick Sampler
instrument tracks,
279-290
Sample Alchemy,
300-306
vocal chops, 291-293
saturation, 346-354
saves
Apple Loop creation,
269-271
Logic Pro autosaves, 34
project saves, 31-34
saving stacks as
patches, 96
scales, 217-219
screen resolution, xv
screensets
customizing locked,
360-362
Tracks/Mixer switching
via, 357-360
sections
arranging drum track
sections, 150-167
continuous repetition of,
6-9
markers for song, 155-
158
selections
anchoring, 11-13
Marquee tool for, 44-47
zooming to fit for, 16-17
Session Player regions
bass track in, 169, 170,
172,173,174
chord progressions
in, 210
color coding for, 18
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Session Player regions (cont.)
converted to MIDI
regions, 158-161
creating tracks for, 139
drum track in, 139-145
editing of, 145-150
instrument variability

in, 189

sets, tempo, 319-321

settings
audio effect plug-in

settings, 73-77
Logic Pro default,
Xiv-xv
new track settings, 32
saving patch/plug-in,
106-109

shakers, 154-155, 162, 163,
323-326

shortcuts, keyboard, 62

side sticks, 151, 154

signal chain, 350

signal routing, 85

silent gaps, 264

Silverlake Drum Machine
Designer, 241

Slice mode, 281, 282,

291, 293

slicing regions

Apple Loop slices,
261-263
reordering slices,
294-298

repeating slices,
298-300

slider values, 91, 95

Slides knob, 174, 179, 185

Smart Controls, 22, 29, 84,
87-89, 155

Smart Tempo Editor,

311, 315

Smash patch, 145, 155

snapping, disabling, 47

snares

bridge pattern with,
162-163
custom pattern of,
147-149
decreasing value of, 238
display in
Drummer, 141
intro with, 152-154
programming beats
with, 231, 236, 237,
238, 240
Software Instrument
pack, 18
Solo mode, 70-73, 78,
85,176
songs
distribution of, 404
exporting, 402-404
kickstarting
compositions, 214
markers for song
sections, 155-158
mastering, 399-401
mixing.
see mixing
saturation for character
in, 346-354
transitions in, 160
Sound Library, xii
spectral synthesis, 300
speed fades, 261, 268
speed of playback, 294-298,
326-329
splitting regions, 54-59,
197-199
staccato, 252
stacks of tracks, 95-99, 241,
354-357
Standard Mic Mode, 114
starting playback, 4-5, 7
Stem Splitter, xii, 277
stems, 275, 354
Step Sequencer
content creation in, 229
Learn mode, 244

loading/saving patterns,
233-236
melody/harmonics
in, 229
programming drum beats,
236-241
silencing step selection,
232-233
step automation,
244-246
turning steps on/off,
230-233
stereo field, 59, 63, 365-368
Stereo format, 75
Stereo Out, 21, 89
stopping playback, 4-5
string section, 203-207,
349-352
Strings, 21
stuttering, 261, 291, 396
styles
choosing styles/presets,
142-145
editing drum track,
139-142
matching groove styling,
323-326
submixes, 275, 354-357
summing track stacks, 95-99,
354, 357
syncopation
bass line
syncopation, 174
color coding for, 253
ghost notes and,
143,176
programming beats
with, 237
vocal chops for, 291, 293
synth plug-ins, 72
synthesis techniques, 300
system requirements, Xi—xii

T
takes, multiple, 117-121



tape recorders, analog,
275, 326
tempo
adapting project to audio
file tempo, 309-315
audio file displays
of, 128
changes and curves,
319-323
correcting
pitch/tempo, 309
detecting tempo, 310,
312, 316
editing MIDI, 134
Flex time tempo edits,
330-337
four time values, 7-8
keyboard track, 196
manual tempo
changes, 144
matching custom
loop, 269
matching loop/project
tempo, 39, 315-318
playback speed
adjustments, 54-59
project tempo, 37, 276
tempo set creation,
319-321
tessitura, widened, 194
ticks, 8, 11
timbre, 306, 342
time-stretching
Flex Time for, 309, 330
single note stretches,
335-337
waveform stretching,
330-335
timing.
See tempo
toms/hand percussion
bridge pattern with,
162, 163

decreasing complexity
of, 165
display in
Drummer, 141
hand claps, 166
tools
default, 44
main window tools,
17-27
Marquee tool, 44-47
Zoom tool, 13-16
Track inspector, 20, 24
trackpads, 10
tracks
adding pattern regions to,
241-243
automation curves
for, 392
bass.
see bass track
Chord track.
see Chord track
color codes for, 60-63
copying regions from
existing, 249
drum.
see drum tracks
editing pan of, 365-368
keyboard track, 189-203
multiple plug-ins on,
99-105
naming, 112
new, 32, 112
organizing, 354-362
plug-ins for software
instrument, 69
Quick Sampler
instrument tracks,
279-290
record-enabled, 120
recording onto, 111-112
renaming, 53-54
soloing, 70-73, 74
stems, 275, 276, 354
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string section, 203-207
summing track stacks,
95-99, 241,
354, 357
track stacks for submixes,
354-357
volume level adjustments,
363, 364
Tracks area, 17, 18, 42, 67,
167, 357-360
Tracks view, 4
transitions
abrupt, 160
smooth, 49
transport buttons, 3-6
Transpose parameter, 57-58,
315, 318
transposition, 54-59,
182-183, 249-252
Tuner button, 115
tuning vocal recordings,
338-343
turntable effects, 229, 261,
268, 329

)

uncompressed PCM wave
tiles, 402

undoing actions, 46, 64

U.S. key command preset, xv

\'J
Varispeed, 309, 326-329, 343
velocity
changing note velocity,
252-254
Piano Roll to
determine, 247
universalizing, 254
velocity display, 256, 258
Velocity/Value
button, 238
verses
bass track section, 172,
177, 180, 183
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verses (continued)
chord progressions in,
210, 212-214,
219, 222
drum track section, 155,
158, 160, 161, 163
keyboard track, 191-193
Vertical Zoom, 9, 10-11, 12
Vibrato, 342
vocals
Arpeggiator MIDI effect,
83-84
backup, 387
creating synth pad vocals,
286-290
depth/distance for,
371-374
extracting vocal stems,
275-278
lead vocal chain,
374-387
pan position of, 366
recording, 111-117
synthesis techniques for,
300-306
timbre of, 306, 342
time-stretching of,
335-337
tuning vocal recordings,
338-343
vocal chops,
291-293, 396
volume
adjusting, 63-66, 205,
362-374
compression of,
379-384
fades in, 261, 268
ghost notes, 143
plug-in volume, 79
volume curves, 298-300

w
waveforms
defined, 15
display of loop
waveforms, 37

recording
waveform, 115
slice markers on, 282
time-stretching of,
330-335
wet audio, 89
window organization, 354-
362
workflow
defaults for speedy, 44
key commands for, 3
workspace
anchoring the, 11-13
cycle area/region lengths,
46
importing loops
into, 241
main window panes,
17-27
organizing windows/
tracks, 354-362
screensets for toggling in,
357-360
workstation, xii-xv, 391

Z
Z key, 16-17
Zoom tool, 13-16
zooming in/out
editing via, 41
horizontal/vertical, 9
incrementally, 9-13
key commands for, 29
punching in/out
and, 121
saving zoom levels,
357, 360
screen fit for selections,
16-17
Step Sequencer, 235
Zoom tool, 13-16
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